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I 

INTRODUCTION 
 
 
To fulfill the requirements of a control system, the plant needs a system that can provide specific 
management functions, such as calibration, diagnostics, identification, materials of construction and 
setup for the Field Devices. 
 
Smar AssetView is a software system for on-line network enabled asset management. The primary 
objective is to unleash the powerful diagnostics capabilities found in Fieldbus devices in general and 
particularly in Smar devices, providing several maintenances schemas and making the user 
interface friendlier. 
 
AssetView deals only with devices and is used for the long-term maintenance and device operation. 
AssetView is not restricted to just displaying error messages from the device, but it can take 
devices through test sequences, record data, plot charts and analyze them providing a much more 
sophisticated failure analysis. 
 
Another important characteristic of the AssetView is the web technology based architecture. The 
user interface is the Internet Explorer web browser and it can be used on any Windows platform. 
 
Since there will always be a mix of instrument brands in a plant, it is important to have a 
maintenance tool that is independent of the device manufacturer. The same single software must 
support devices even though these come from different manufacturers. 
 
The device manufacturers know best what information to display, and how to present it for the user 
to get the best out of their device. The device manufacturer is the ideal candidate to make pages 
available for their devices, incorporating their knowledge and visualization characteristics, and 
keeping them up to date with the latest features and capabilities. That's the proposal of AssetView: 
to allow the manufacturers to develop the devices' home pages. 
 
AssetView software is network enabled and allows the user to tap into the information of the 
devices, indicating the condition of any device at any time, so that users can have a complete 
overview to picture the status of the entire plant. 
 
 

ATTENTION 

The AssetView HMI manuals describing the identification, configuration, calibration and other 
device pages are available at the Smar Web Site: http://www.smar.com.br 

 
 
This product is protected by U.S. patent numbers 6,631,298; 6,725,182 and other U.S. Patents 
pending. 
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Section 1 
 

1.1 

 

INSTALLATION AND CONFIGURATION 
 
 

Installing AssetView with System302 version 7.0.x or higher 
 
If you are installing AssetView with System302 version 7.0 or higher, please refer first to the 
System302 Installation Guide available in the System302 Documentation and follow the 
instructions to complete the installation and configure your system. 
 
Then, refer to the steps described in subsections After the Installation and AssetView Initial 
Settings in this manual, and configure specific system settings to execute AssetView properly. 
 
 

Installing AssetView with System302 Version 6.1.x 
 
Before installing AssetView with System302 version 6.1.x, you must have already installed some 
essential applications that support Smar software. 
 
 
Installing Internet Explorer 6.0 or higher 
 
The Internet Explorer installation file is located at the folder Tools\IE6, in the System302 CD. 
 
Run the application Ie6setup.exe and follow the instructions in the dialog boxes to complete the 
installation. It will be necessary to restart the computer after the IE installation. 
 
 
Installing IIS on Windows XP or Windows Server 2003 
 
Install the Internet Information Services (IIS), version 5.0 or higher. The IIS is a Windows Add-on 
Component. Place the Windows CD in the CD-ROM drive. Open the Control Panel and double-
click the Add or Remove Programs application. 
 
In the Add or Remove Programs window, click Add or Remove Windows Components on the 
menu on the left. The Windows Components Wizard dialog box will open. 
 

• On Windows XP, mark the item Internet Information Services (IIS) and click Next. Follow 
the instructions to complete the IIS installation and click Finish. 

 

 
Figure 1.1. Installing IIS on Windows XP 
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• On Windows 2003 Server, select the item Application Server and click Details. In the 
Application Server dialog box, mark the items ASP.NET and Internet Information 
Services (IIS) and click Ok. In the Windows Component Wizard, click Next and follow 
the instructions to complete the installation. Click Finish to conclude. 

 

 
Figure 1.2. Installing IIS on Windows 2003 

 
 

IMPORTANT 

If IIS was already installed in the machine but the ASP.NET was not installed, it will be necessary 
to remove IIS and install ASP.NET together with IIS. 
In this case, open the Application Server dialog box and unmark the item Internet Information 
Services (IIS). Click Ok and click Next on the Windows Components Wizard window. Follow 
the instructions to uninstall IIS. 
Then, open the Windows Components Wizard window again, select the item Application 
Server and click Details. Mark the items ASP.Net and Internet Information Services (IIS), click 
Ok and follow the instruction to complete the installation. 

 
To check if the installation was successful, open the Internet Explorer window and type the machine 
name or “localhost”. The Internet Information Services page should be loaded. 
 
 
Installing AssetView 
 

IMPORTANT 

To install AssetView, the user must be logged on as the Administrator or a member of the 
Administrators group. 
If AssetView will be installed in a domain, the user installing the software must have 
administrator rights to access the domain. 

 
Place the System302 Installation DVD at the DVD-ROM driver. The Installation dialog box will 
automatically open. Click Install SYSTEM302. 
 
Follow the instructions in the dialog boxes, providing the necessary information during the 
installation. 
 
Make sure to select the Custom installation mode. In the Select Features dialog box, check the 
option AssetView from the list of applications available: 
 



Installation and Configuration 

 

1.3 

 
Figure 1.3. Installing AssetView 

 
It will be necessary to restart the computer after the installation is complete. 
 

IMPORTANT 

If a database application is not located during the AssetView installation, the MSDE database 
will be automatically installed. 
If any error message appears during the AssetView installation and configuration, please refer to 
the section Known Problems and Limitations for details on how to manually configure the 
system. 

 
 
AssetView Licensing 
 
AssetView Server requires a HardKey to run properly. A specific number of field devices will be 
managed according to the license option select by the user. 
 
The following table shows the license types available according to the maximum number of field 
devices installed on the plant. 
 
Note that if there are more than 200 instruments, it will not be possible to use the MSDE database, 
only the SQL Server database. 
 

Option Number of Devices Database Required 

1 25 MSDE or SQL Server 

2 100 MSDE or SQL Server 

3 200 MSDE or SQL Server 

4 300 SQL Server 

5 400 SQL Server 

6 500 SQL Server 

7 750 SQL Server 

8 1000 SQL Server 

9 1500 SQL Server 
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A 2000 SQL Server 

B 2500 SQL Server 

C 3000 SQL Server 

D 4000 SQL Server 

E 5000 SQL Server 

F 7500 SQL Server 

G 10000 SQL Server 
 
Connect the HardKey to the parallel port or USB port in the machine. Then select Start > Programs 
> System302 and click Get License. 
 

 
Figure 1.4. Checking the HardKey 

 
On the Get License application, Hard keys are automatically detected. Click the button Details to 
open the diagnostic report about Hard Key(s). Click Exit to conclude. 
 

NOTE 
If an error message appears during the test, check if the Hard Key is connected properly and if 
you have a valid license. 

 
 

After the Installation 
 
Remember that it is necessary to restart the computer after the installation is complete. 
 

NOTE 
AssetView supports MSDE and SQL Server versions 2000 and 2005. 

 
Configuring the Windows Firewall 
 

NOTA 
The following steps are not required for System302 versions 7.3.4 SP1 or higher. See the 
SYSTEM302 Handbook (GetStarted) for further information. 

 
If the Windows Firewall is enabled, add the port 80 used by AssetView to the exception list: 
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1. Open the Windows Control Panel and double-click the option Windows Firewall. 
 

2. The Windows Firewall dialog box will open. Click the Exceptions tab: 

 

Figure 1.5. Configuring the Windows Firewall 
 

3. Click the button Add Port. 

4. On the Add a Port dialog box, type Web as the port name and type 80 for the port number. 
Select the TCP protocol and click Ok to conclude. 

 

Figure 1.6. Configuring the Port 80 
 

5. Click Ok on the Windows Firewall window to conclude. 

 
 
Configuring the DCOM Properties Manually 
 
Advanced security properties from Windows XP SP2 and Windows Server 2003 SP1 must be 
configured to enable the communication between AssetView and System302 components. For 
operating systems Windows 7, Windows Server 2008, or higher refer to SYSTEM302 Handbook 
(GetStarted) for further information. 
 
On the Start menu, click Run, type dcomcnfg and click Ok. The Component Services window will 
open. On the left panel, select Component Services > Computers > My Computer. 
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Right-click the icon My Computer and select the option Properties. On the My Computer 
Properties dialog box, select the Default Properties tab and check if the option Enable 
Distributed COM on this computer is marked. 
 

Select the COM Security tab. Click Edit Default on the Access Permissions area. The Access 
Permission dialog box will open: 
 

 

Figure 1.7. Configuring the Access Permission 
 
Click Add and include the user ASP.NET and the following groups: Administrators, Users, 
Interactive, System, Engineer, AssetViewGuest. See the example in the figure below: 
 

 

Figure 1.8. Adding Users and Groups 
 
Click Ok to return to the Access Permission dialog box. For each user and group added, select its 
icon and mark the Allow column for the options Local Access and Remote Access. 
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Figure 1.9. Local and Remote Access Permissions 
 
Click Ok to return to the My Computer Properties dialog box. Then, click Edit Default on the 
Launch and Activation Permissions area and repeat the steps described above to add the same 
user and groups, allowing the permission for Local Launch, Remote Launch, Local Activation, 
and Remote Activation. 
 

 

Figure 1.10. Launch and Activation Permissions 
 
Click Ok to return to the My Computer Properties dialog box and click Ok again to conclude. 
 
 

AssetView Initial Settings 
 
On the Start menu, select Programs > System302 > AssetView > Installation Guide. The 
AssetView Welcome Screen will open. 
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NOTE 

When you run AssetView Server for the first time, the AssetView Welcome Screen opens to 
guide the user while configuring the system. 

 

 
Figure 1.11. AssetView Welcome Screen 

 
The Welcome Screen indicates the status of the AssetView installation. For example, if the user is 
executing the application for the first time, the Welcome Screen indicates that the database is not 
configured. 
 
If an error message appears indicating that the HardKey is not valid, check if it is connected properly 
and if you have a valid license. See section AssetView Licensing for further details. 
 
Use the links in the Welcome Screen and follow the instruction in the sections below to configure 
the computer to run the AssetView and AssetView Server applications. 
 

IMPORTANT 

When installing AssetView in a domain, the groups Engineer and AssetViewGuest are created 
in the domain server machine and all other users must be created in the same machine. The 
message in the figure below appears when AssetView is executed for the first time, when the 
Welcome Screen appears: 

 
In this case, make sure the user with administrative rights runs AssetView for the first time to 
execute and complete the necessary initial settings. 

 
 



Installation and Configuration 

 

1.9 

Creating the Database 
 
Run this procedure in the machine that hosts the database server to create the AssetView 
database. 
 
It is not necessary to install System302 and the database on the same machine, because the 
AssetView Server can remotely access the database. The SQL Server can be installed in any 
computer that communicates with the AssetView Server. 
 

IMPORTANT 

The database for AssetView version 4.1 or higher is not compatible with previous AssetView 
versions. When creating the database, the history of all registers and operations will be deleted. 
For further information on how to keep the database history from versions previous to AssetView 
4.1, contact your Smar representative. 
To create the AssetView database, the user must be logged as the Administrator or a member 
of the Administrators group. 

 
In the Welcome Screen, click the link Creating Database. The Configure SQL Server Database 
dialog box will open: 
 

 
Figure 1.12. Configuring the SQL Server Database 

 
Select the AssetView database server from the drop-down list and click Create. 
 
If the database already exists in the selected server, a message box will open asking if the user 
wants to create a new database. Click Yes and all existing data will be deleted. 
 
Wait a few seconds until the message box opens alerting the user that the database was created. 
Click Ok to close this dialog box: 
 

 
Figure 1.13. Creating the SQL Server Database 

 
NOTE 

If the database was not created properly, check the SQL Server configuration and the user login 
information. 

 
 
Click Close to conclude the database configuration. 
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Creating the Remote Database 
Follow this procedure to create the AssetView database in a dedicated machine, that is, in the 
remote computer where all database information will be saved. 
 
Locate the AssetView installation folder. The default path is “C:\Program Files\Smar\AssetView”. 
Copy the folder SQL Server Support to the remote machine and run the file SqlServer.exe, 
double-clicking its icon. 
 
Select the database server from the drop-down list and click Create. When the database is created, 
click Close to conclude. 
 
 
Database Configuration File 
 
Now check if the database connection is configured properly. In the Welcome Screen, click the link 
Database Configuration File. The Data Link Properties dialog box opens. 
 

 
Figure 1.14. Connecting to the SQL Server Database 

 
At the Connection tab: 
 

1. Select the name of the SQL Server. 

2. Choose the log on mode. 

3. Select the AssetView Database on the server. 
If the database was created in the remote machine, make sure to select the name of the 
remote server. 

4. Click Test Connection and wait for the message confirming the test succeeded: 

 
Figure 1.15. Testing the connection 

 
Click Ok on the Data Link Properties dialog box to conclude. 
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User Permission 
 
In the Welcome Screen, click the link User Permission to open the Local Users and Groups 
window. 
 
Only the AssetView administrator can configure the access level. The access control of AssetView 
uses the Windows authentication, and for this reason the AssetView administrator is the 
administrator of the machine where the System302 was installed. 
 

 
Figure 1.16. Local Users and Groups Window 

 
Users added to the Engineers Group will have permission for writing and reading information from 
the server. Double-click the Engineer group to open the Engineer Properties dialog box. 
 
Click Add and select the user(s) to be included in the Engineer group. Click Ok to confirm and 
conclude this procedure. 
 
Users added to the AssetViewGuest group will only have permission to read information from the 
server. Double-click the AssetViewGuest group to open the Properties dialog box. 
 
Click Add and select the user(s) to be included in the AssetViewGuest group. Click Ok to confirm 
and conclude. 
 
 
Email Server 
 
In the Welcome Screen, click the link Email Server to configure the SMTP Server address. The 
Mail Options dialog box will open: 
 

 
Figure 1.17. Configuring E-mail Options 

 

1. Type the name or the IP address of the e-mail server in the SMTP Server box. 

2. Configure the maximum idle time, in milliseconds, for the communication with the e-mail server 
in the TimeOut box. It is recommended to use a value 10 times bigger than the server's 
response time. 

3. Configure the e-mail account for AssetView. 
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4. If the e-mail server requires authentication, select Yes in the Use Authenticate Mode box and 
type the password for the e-mail address in AssetView. 

5. If the mail server uses the SSL protocol, check the option SSL and type the corresponding 
number for the SMTP port, on the SMTP Port box. 

6. Click Ok to save the changes and close this dialog box. 
 

NOTE 

Some e-mail servers may require a Domain and User name instead of the email address to 
configure the AssetView Email Account field. 

 
 
Configuring the Communication 
 
In the Welcome Screen, click the link OPC Server to configure the communication interface. The 
Communication Settings dialog box will open: 
 

 
Figure 1.18. Configuring the Communication 

 
Select the communication server from the list of available servers. Click Ok to conclude. 
 
 
Selecting the Topology Configuration 
 
In the Welcome Screen, click the link Configure Area to select the project configuration that will be 
used by the AssetView Server. The Areas dialog box will open: 
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Figure 1.19. Areas dialog box 

 
Click the combo box on the upper right corner on the Areas dialog box to select the configuration 
from the list of configurations available and click Ok. 
 
If the desired configuration is not listed on the combo box, click the button ... as indicated in the 
figure above and the Open dialog box will open. Browse the folders to locate the configuration file 
with the extension .ffp. Select the file icon and click Open to import the plant project configuration to 
the AssetView Server. 
 

 
Figure 1.20. Selecting the configuration file 

 
 

ATTENTION 

From System302 version 7.0.x on, project configuration files are managed by Studio302. Those 
files are saved in the corresponding project folder, in a common directory. The default path to 
project folders is C:\Program Files\Smar\ConfigurationWorkspace\Client\CWFiles\System302. 

 
 
A message box will open indicating the topology was stored in the database. 
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Figure 1.21. Selecting the configuration file 

 
Click Ok to return to the Areas dialog box and click Close to conclude. 
 
Now the system is ready to execute the AssetView Server and navigate on the AssetView devices’ 
pages. 
 
Click Launch Smar AssetView Server to start AssetView Server. The following sections on this 
manual will describe the AssetView Server interface and how to navigate the pages available for 
the field devices  
 
 
 
 



Section 2 
 

2.1 

 

ASSETVIEW SERVER 
 
 
The Smar AssetView Server runs transparently to the user. The AssetView Server monitors the 
devices, controls the number of devices monitored and grants permissions to users. 
 
Before initializing the AssetView Server, it is necessary to: 

1. Create the device configuration using Syscon. 

2. Export the tags. 

3. Initialize the communication using Syscon to check if the settings are correct. 

4. Check if the Online Characterization window shows the parameter values in Syscon. 
 
It is not necessary to keep the Syscon window open while executing the AssetView Server. 
Remember that Syscon and AssetView can be installed separately, on different computers. Refer 
to the Syscon User’s Manual for details about project configurations. 
 
 

Starting AssetView Server 
 
Using System302 Version 6.1 
 
To open the AssetView Server window, click Start > Programs > System302 > AssetView > 
AssetView Server: 
 

 
Figure 2.1. Initializing the AssetView Server 

 
 
Using System302 Version 7.0.x 
 
From the Start menu, select Programs > System302 > Studio302 and click Studio302, as 
indicated below: 
 

 
Figure 2.2. Starting Studio302 

 

Click the button on the Studio302 toolbar and the following dialog box will open: 
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Figure 2.3. Initializing the AssetView Server 

 
Click the option AssetView Server to execute this application. The following figure shows the 
AssetView Server window: 
 

 
Figure 2.4. AssetView Server Interface 

 
At the bottom of the AssetView Server window, the status bar indicates the configurations made by 
the user at the AssetView Welcome Screen, when the tool is executed for the first time. This 
means that the status bar indicates the OPC server selected for the communication, the e-mail 
server, the number of licenses available according to the number of the devices registered in the 
AssetView Server database, and also indicates if the connection to the database is active. 
 
 

Selecting the Topology 
 
Click Open Topology on the main menu to read the configuration from the Syscon file selected on 
the Welcome Screen, which was configured when AssetView is executed for the first time. 
 
Wait a few seconds while the information from blocks and devices are read from the configuration 
file and from the communication network, in case the configuration has HART devices. 
 

ATTENTION 

To read information from another project configuration, it will be necessary to create the database 
again and include the configuration file, at the AssetView Welcome Screen. Refer to the section 
Selecting the Topology Configuration for details. 

 



AssetView Server 
 

2.3 

Registering Devices 
 
When executing AssetView Server for the first time, there are no devices registered in the 
database. Registering a device implies the parameter values from this device are read and stored in 
the database, and after that it is possible to monitor maintenance and diagnostic events, for 
example. 
 
On the main menu, click the option Register to open the List of Devices dialog box. 
 

 
Figure 2.5. List of Devices 

 
Text displayed in orange means the device can be registered but some restrictions apply. Missing or 
outdated information are indicated in the Register Device Details text box, at the bottom of the 
dialog box. Select the device on the table to display the details about the status. 
 
Mark the devices to be registered in the database. To select all devices, click the button Select All. 
To unmark all devices, click the button Clear Selection. 
 
The procedure to register the devices has a time limit variable and its default value is 3 minutes. 
This value can be edited in the Register Time Out box. When the idle time interval defined by the 
user expires, the register procedure for the instrument being registered is aborted. 
 
Click Register to start registering the selected devices in the database. 
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IMPORTANT 

For Smar's Fieldbus devices, it is recommended to use the firmware version 3.46. Some 
parameters and methods may not be available for devices with other firmware versions. The List 
of Devices dialog box indicates the functionalities missing in the selected device: 

 
AssetView can monitor HART devices using the Smar HI302 - HART/Foundation Fieldbus 
Interface. It is necessary to update the firmware version to 0601 (6.01 or higher) and create the 
blocks configuration for the HI302. Please refer to the HI302 User’s Manual (Chapter 3) for 
further information. 
The current AssetView version supports the devices FY301, LD301, TT301, DT301, TP301 and 
FY400. Other HART devices will use a generic page, as well as the devices from other 
manufacturers. 

 
If a device selected to be registered does not have all required blocks or has an old firmware 
revision, the device will be registered in the database but some functionalities, such as calibration 
and diagnostic methods, may not be available. 
 
The example on the figure below shows the dialog box that will appear while the instruments are 
being registered: 
 

 
Figure 2.6. Registering devices 
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If the selected devices have Maintenance Templates, AssetView Server will register these 
maintenances after registering the blocks. See section Maintenances Templates for details about 
the AssetView Maintenance Wizard. 
 

 
Figure 2.7. Programming Maintenances 

 
The Register Report window will open indicating if the instruments were registered with success. 
See the example below: 
 

 
Figure 2.8. Details Window 

 
Click the button Start Tracking to start monitoring and tracking the devices. Refer to the section 
Tracking for further details. 
 
 

Tracking 
 
The Tracking option initializes the monitoring of the devices registered in the database, storing the 
changes of the parameter values in the historical information. 
 
On the main menu, click the option Tracking. AssetView Server starts monitoring the information 
from the Fieldbus network and the Tracking window displays the information about the devices 
being monitored. 
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Figure 2.9. Tracking results 

 
ATTENTION 

Devices must be registered in the database and online on the Fieldbus network to be monitored. 
 
 
Tracking Failings 
 
If a device is displayed in the Tracking window with a red X on its icon, it means that the device is 
not being monitored because of a failure in the communication. 
 
A typical example of a communication failure occurs when the device goes offline and returns to 
online mode after a short period of time. The system automatically detects when the instrument 
starts communicating again. The monitoring process is restarted and the device icon in the 
Tracking window is restored to its normal state. 
 
Right-click the device icon and select Failing Reason to see the details about the tracking fail. This 
option is also available in the device popup menu, in the Device List window. 
 

 
Figure 2.10. Failing Reasons 

 
 

NOTE 

To stop tracking the devices, it is necessary to close AssetView Server. In the Topology menu, 
click Exit. 
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Managing Devices in the Database 
 
You can check the list of devices registered in the database or remove a device register from the 
database. The Devices List dialog box has two view modes that can be selected clicking the 
buttons Details and Thumbnails on the upper right side of the window. 
 

 
Figure 2.11. Device List Dialog Box - Details View 

 
The option Detils displays information about the devices, such as the manufacturer, device type and 
protocol. Click the column header to sort the list of devices, toggling between ascendant and 
descendent sorting. 
 
The option Thumbnails shows only the devices registered on the database that are being 
monitored. 
 

 
Figure 2.12. Device List Dialog Box - Thumbnails View 

 
The devices displayed in this dialog box are configured in the Syscon file. The Tracking procedure 
reads the information related to these devices from the database and from the Fieldbus Network. 
See section Tracking for further information about monitoring a device. 
 
You can manage the devices adding or removing their register from the database, according to the 
number of devices allowed by the License Key to be included in the topology. 
 
 
Unregistering Devices 
 
On the Device List dialog box, right-click the device icon and select the option Unregister. 
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Figure 2.13. Unregistering a Device 

 
The option Unregister is also available from the Thumbnails view on the Tracking window. 
 
A message box opens to confirm the operation. Click Yes to remove the device register from the 
database or click No to cancel. Another message box indicates to the user that the operation was 
concluded with success. Click Ok to conclude. 
 
 

Event Log 
 
The log with the events executed in AssetView Server is shown at the bottom of the AssetView 
Server window. 
 

 
Figure 2.14. Event Log window 

 
In case an error occurred, it is indicated in red. Double-click the corresponding row in the Event Log 
window to open the Error Message that provides information about the error. 
 

 
Figure 2.15. Error Details 

 
 
Deleting the Event Log 
 
Click the button Clear on the right side of the window to delete all the information in the Event Log 
window. 
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User Management 
 
It is necessary to configure permissions for users to access the AssetView Server. Click User on 
the main menu to open the dialog box: 
 

 
Figure 2.16. Users dialog box 

 
 
Adding Users 
 
Click the Add button to add a new user. The Add Users dialog box will open: 
 

 
Figure 2.17. Adding Users 

 

1. Select the group to which the user will be added: Engineers or AssetViewGuest. Users 
added to the Engineers group will have permission for writing and reading information from 
the server. Users added to the AssetViewGuest group will only have permission to read 
information from the server. 

2. Type the user name. 

3. Type a brief description for the user. 

4. Type the user's full name. 

5. Choose a password for the user. 

6. Type the user's e-mail. 

7. Click Ok to conclude. 
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Adding Existing Users 
 
On the Add Users dialog box, click Existing to open the list of users for the local machine: 
 

 
Figure 2.18. Existing Users 

 

1. Select the user name from the list of existing users. 

2. Select the group to which the user will be added: Engineers or AssetViewGuest. 

3. Type the user's e-mail. 

4. Click Ok to conclude. 
 
 
Editing User's Attributes 
 
Only the e-mail address can be altered, it is not possible to change the user’s name or password, for 
example. 
 
On the Users dialog box, click Edit to open the Add User dialog box and type the new e-mail 
address. Click Ok to conclude. 
 
 
Removing Users 
 
Click the user’s name in the Users dialog box and click Delete. 
 
A message box opens to confirm the operation. Click Yes to proceed and remove the user from the 
group of AssetView users. 
 
Another message opens to confirm whether the user should be removed from Windows. Click Yes 
to remove the user from the operational system, or click No and the user will only be removed from 
the group of AssetView users. 
 
 



Section 3 
 

3.1 

 

ASSETVIEW AREAS 
 
 
For many reasons, a large plant is usually divided into several areas. From the AssetView point of 
view, each area is represented by one particular AssetView Server, which will be in charge of 
registering all devices and keeping track of them. 
 

Area_3 AssetServer_3

Internet/Intranet

Area_4 AssetServer_4

Area_1

AssetServer_1

Area_2

AssetServer_2

Client

 
Figure 3.1. Managing different areas 

 
AssetView provides a Web page with links to all these areas, so the user can easily navigate 
through these areas just by clicking a link. This Web page can be opened from any of the 
AssetView Server machines as well as any other client computer (intranet/internet) that has a 
browser installed. To achieve this functionality, follow the steps below to configure the AssetView 
areas. 
 
To open the AssetView Areas window, go to the Start menu and select Programs > System302 > 
AssetView > AssetView Areas, as indicated below: 
 

 
Figure 3.2. Initializing the AssetView Areas 

 
The AssetView Areas window will open: 
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Figure 3.3. Configuring Areas 

 
 

Changing Areas Attributes 
 
Select the area icon from the list of areas. On the main menu, select Area and click Change 
Attributes. The Change Attributes dialog box will open. 
 

 
Figure 3.4. Changing Areas Attributes 

 
At the AssetServer IP address text box, type the new IP address or the network machine name 
where the devices from this area have been registered. Click Change to conclude. 
 
Repeat the steps described above to change the attributes from other areas. 
 
 

Opening the Areas Topology 
 
Open the Web browser and type the web address to the Areas page: http://<server 
address>/assetview/area.htm 
 

IMPORTANT 

The Areas page must be opened in the browser using the server address or the name of the 
server machine where the areas were configured with AssetView Areas. The address is 
indicated in the column IP corresponding to the area, in the Configure Areas window described 
above. 
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Click the expansion sign next to the plant icon to expand the tree and see the links to the areas: 
 

 
Figure 3.5. Areas topology 

 
Clicking a link to an area will open the AssetView page from the respective machine, identified by 
the IP address configured previously by the AssetView Areas application. On the AssetView page, 
the user must type the login and password to open the configuration topology tree and access the 
AssetView functionalities. 
 

 
Figure 3.6. User Authentication 
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Once the user name and the password are correct, the AssetView topology will open on the 
browser, as illustrated below: 
 

 
Figure 3.7. Loading the topology 
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ASSETVIEW 
 
 

Loading the Configuration 
 
To start AssetView, open the Internet Explorer and type: 
 

http://machine name/assetview (local or remote access) 
or 

http://localhost/assetview (local access) 
or 

http://machine IP_number/assetview (local or remote access) 
 

 
Figure 4.1. AssetView Home Page 

 
On the AssetView main page, the user will have to type the login and password to access the 
configuration topology tree and the AssetView functionalities. 
 
 

ATTENTION 

If AssetView is installed in a domain, it will be necessary to type the domain name to access the 
AssetView functionalities. 

 
 
AssetView reads the network topology from the Syscon configuration file. The user can browse the 
operational devices at different plant locations using AssetView. 
 
The frame on the left side of the browser window will display the plant topology. Click the expansion 
sign to expand the Fieldbus Network and its segments. 
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Figure 4.2. Browsing the Topology 

 
 

Opening the Device Home Page 
 
Each device type has a standard home page layout. Every device in a plant location has a home 
page from where the user can proceed with the calibration, configuration, identification, diagnostics 
or reconciliation of the device configuration. 
 
Navigating through the topology tree, click on any device icon to display its home page. The figure 
below shows the home page of the LD302 with the tag name LD 302: 
 

 
Figure 4.3. Device Home Page 
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According to each device type, the main page may have the following links: 
 
Calibration 
 
Calibration is the correction of sensor reading and physical outputs. During this process messages 
are displayed to the user indicating the status of this condition. There are specific calibration 
methods for each device based on scripts defined by the manufacturers. 
 
 
Configuration 
 
In the Configuration page, the user can read and write the parameter values of the devices. From 
this page, the user can also access the Reconciliation page and compare the current configurations 
to previous configurations of the devices stored in the database. Refer to subsection 
Reconciliation. 
 
 
Diagnostics 
 
Simple diagnostics are displayed to the user. Comprehensive tests can be done from time to time 
using several charts to check the condition of the field device. Because of the diagnostic it is 
possible to first remotely check the device if there really is a failure before going into the field. And 
yet, because of the detailed information about the Network and device operation provided by the 
diagnostics, the user knows exactly where the problem is. 
 
 
Identification 
 
The Identification page provides all the information relevant to maintenance of the device, such as 
its manufacturer, device type, tag, serial number, and its versions. Materials of construction for 
wetted parts are also indicated. 
 
 
Device View 
 
The Device View page monitors the instrument data, such as temperature or pressure values read 
from the instrument. 
 
 
Display 
 
In the Display page, the user can configure the device’s display, viewing and modifying parameters 
such as device mnemonics. 
 
 
Reconciliation 
 
Reconciliation allows comparison of current device settings with past configurations stored in the 
database. 
 
The Time menu on the left side of the page list the modifications made in the device, including the 
last modification that is also called the “current device parameterization”. The Time menu on the 
right side also list the modifications made in the device except date and time for the current device 
parameterization. 
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Figure 4.4. Reconciliation Page 

 
Values of parameters that differ between the selected modification dates are highlighted. 
 
When the parameter values differ between the two dates selected in the Time menu, it is possible to 

transfer the value from the moment selected on the right clicking the arrow  between the 
highlighted values. After transferring the values, click Submit to apply the values to the device and a 
new modification date will be created on the Time menu indicating the current time and date. 
 
 

Integrating Devices 
 
HART Devices 
 
AssetView monitors HART instruments using the Smar HI302 (HART/Foundation Fieldbus 
Interface). 
 
It is necessary to create the blocks configuration for the HI302 to represent the HART instruments 
installed in the plant. Please refer to the HI302 User’s Manual (Chapter 3) for further information. 
 
If the HART instrument being registered with the AssetView Server has not been registered in the 
database, this instrument will be registered as a generic instrument. The List of Devices dialog box 
will indicate the instrument is generic: 
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Figure 4.5. Generic HART Device 

 
Select the HART instrument and the Details box will indicate the device is generic and it is ready to 
be registered. 
 

 
Figure 4.6. Registering a Generic Device 

 
HART instruments from Smar or other manufacturers that don't have registered pages will use the 
generic pages located in the folder "Web Pages\Hart Device Support\GenericHart", inside 
the AssetView installation folder. 
 
Observe the figure below: 
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Figure 4.7. Generic Pages for HART Instruments 
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DEVICE AND CONTROLLER LIST 
 
 

Device List 
 
Click the link Device List to open a page with the list of all devices in the topology from the project 
configuration selected in AssetView Server: 
 

 
Figure 5.1. Device List Page 

 
At the top of the page, use the Tag Search box to search for a specific device tag: 
 

 
Figure 5.2. Searching for a Device 

 
 
Type the desired text and the tags list will be shown dynamically based on that the user has typed. 
 
You can order the list of devices in alphabetical order, ascendant or descendent, clicking each 
column header. 
 
In the Tag column, click the device tag to open the device home page. 
 
The Bridge and Channel columns indicate the tag of the controller and to which channel the 
instrument is connected, respectively. 
 
In the Track column, the following icons indicate the device status: 
 

 Indicates the device has communication problems. 

 Indicates the device is operating in normal conditions. 

 Indicates the device is off-line. 

 Indicates a HART device operating in normal conditions. 
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In the Diag column, the following icons indicate diagnostic events: 
 

 Indicates that a diagnostic event has occurred. 

 Indicates a HART device and there is a diagnostic event for the device. 

 Indicates the device is operating in normal conditions. 

 
In the Maint column, the following icons indicate the maintenance status for the device: 
 

 Indicates there are no pending maintenances for the device. 

 Indicates that maintenance should be executed in the device. 

 
 

Controller List 
 
Click the link Controller List to open a page with the list of all controllers in the topology from the 
project configuration selected in AssetView Server: 
 

 
Figure 5.3. Controller List Page 

 
At the top of the page, use the Tag Search box to search for a specific controller tag, as described 
previously for searching a device. 
 
Click the column header to order the list of controllers in alphabetical order, ascendant or 
descendent. 
 
In the Tag column, click the controller to open its home page. 
 
In the Track column, the following icons indicate the controller status: 
 

 Indicates the controller has communication problems. 

 Indicates the controller is operating in normal conditions. 

 Indicates the controller is off-line. 

 
In the Diag column, the following icons indicate diagnostic events: 
 

 Indicates that a diagnostic event has occurred. 

 Indicates the controller is operating in normal conditions. 
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In the Maint column, the following icons indicate the maintenance status for the controller: 
 

 Indicates there are no pending maintenances for the controller. 

 Indicates that maintenance should be executed in the controller. 
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6.1 

 

AUDIT TRAIL REPORTS 
 
 
AssetView has different types of reports to be configured by the user. Click the link Audit Trail 
Report to open the page with available reports. 
 

 
Figure 6.1. Audit Trail Reports in AssetView 

 
The subsections below describe the functionality of these reports and how to generate them. For all 
reports, the following filters will be available: 
 

 
Figure 6.2. Filters for the Reports 

 
• START DATE: Select the initial date to search for the information to generate the report. 

 
• END DATE: Select the final date to search for the information to generate the report. 

 
• PROTOCOL: Select the devices of a specific communication protocol (HART or Fieldbus). 

 
• DEVICE TYPE: Select the type of the device from the list of devices registered in the 

database. 
 

• DEVICE TAG: This filter will display the list of tags from the devices registered in the 
database. 

 
After configuring the filters, select the file format to generate the report: 
 

 Click this icon to generate the audit trail report in the pdf file format. 

 Click this icon to generate the audit trail report in the MS Excel file format. 
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ATTENTION 

According to the settings on your browser, the dialog box showed in the example below may 
open when selecting the MS Excel file format: 

 
Click Open to open the audit report inside the browser window or click Save to save the report 
file in the local machine. 

 
 

Configuration Changes Report 
 
This report shows all changed parameters of the device in a specific period of time. 
 
To generate this report, click the link Configuration Changes in the Audit Trail Reports page and 
configure the filters to generate the report in the pdf or xls file format. 
 
See the example below in pdf format: 
 

 
Figure 6.3. Configuration Changes Report 
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Device Data Report 
 
This report shows the current status of the device in a specific period of time, listing the last values 
of all parameters at the selected date. 
 
To generate this report, click the link Device Data in the Audit Trail Reports page and configure 
the filters to generate the report in the pdf or xls file format. 
 

 
Figure 6.4. Device Data Report 

 
 

Application Log Report 
 
AssetView stores the tags of the devices in the database. This report shows all devices to which a 
specific tag has been assigned. 
 
To generate this report, click the link Application Log in the Audit Trail Reports page and 
configure the filters to generate the report, in pdf or xls format. 
 

 
Figure 6.5. Application Log Report 
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Device ID Log Report 
 
This report shows all tags that have been assigned to a specific device ID. 
 
To generate the report, click the link Device ID Log in the Audit Trail Reports page and configure 
the filters to generate the report, in pdf or xls format. 
 

 
Figure 6.6. Device ID Log Report 

 
 

Tracking History Report 
 
This report shows the occurrences of communication failures. 
 
To generate this report, click the link Tracking in the Audit Trail Reports page and configure the 
filters to generate the report, in pdf or xls format. 
 

IMPORTANT 

While the fail event is not acknowledged by any user, the user name displayed on the report will 
be “System”. Once a user acknowledges the event, the name displayed on the report will be 
updated with the login name of that user. 

 

 
Figure 6.7. Tracking History Report 
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Diagnostic History Report 
 
The diagnostic events indicate failures or operational conditions of the devices, and they are stored 
in the AssetView database. 
 
To generate this report, click the link Diagnostic History in the Audit Trail Reports page and 
configure the filters for the report. Click the icon corresponding to the desired file format: pdf or xls. 
 

 
Figure 6.8. Diagnostic History Report 

 
 

Method History Report 
 
Methods are calibration procedures composed by a sequence of reading and writing in the device. 
The parameter values before writing and the values that were written in the parameters, static or 
dynamic, are stored in the database. 
 
This report shows all methods performed and the parameters that have been changed. 
 
To generate this report, click the link Method History in the Audit Trail Reports page. Configure 
the filters and click the icon corresponding to the desired file format: pdf or xls. 
 

 
Figure 6.9. Method History Report 
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Maintenance Report 
 
This report shows all maintenances scheduled and performed for each device. 
 
To generate this report, click the link Maintenance History in the Audit Trail Reports page and 
configure the filter options. Click the icon corresponding to the desired file format, pdf or xls, to 
generate the report. 
 

 
Figure 6.10. Maintenance Report 

 
 

H1 Network Statistics Report 
 
The report generates statistic charts for controllers, representing the values read from the H1 
fieldbus channels configured in the plant topology, indicating the date the statistics were calculated 
and fails occurred in the controller. Using the charts, it is possible to predict potential communication 
fails between the controller and field devices, and avoid interruptions in the network communication 
and connected devices. 
 
To generate this report, click the link H1 Statistics in the Audit Trail Reports page and configure 
the filter options. Click the icon corresponding to the desired file format, pdf or xls, to generate the 
report. 
 
See the example below: 
 

 
Figure 6.11. H1 Statistics Report 
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MONITORING DEVICE STATUS 
 
The field devices notify the system when a communication failure or operational conditions occur. 
 
To display the events reported to AssetView, click the link Status in the topology to expand the 
monitoring options. 
 

 Indicates normal condition, no communication problem occurred. 

 Indicates that a diagnostic event or communication problem has occurred. 
 
 

Tracking 
 
The Tracking View page shows the status of the devices and their location. 
 

 Indicates normal condition, no communication problem occurred. 

 Indicates that a communication problem has occurred. 
 
When the device is disconnected from the plant or has communication problems, it appears in the 
tracking list. Click the link Status > Tracking in the topology to open the Tracking List: 
 

 
Figure 7.1. Tracking List 

 
The Bridge and Channel columns indicate, respectively, the tag of the controller and to which 
channel the device is connected. 
 
Click the magnifying glass icon to open a new window that shows detailed information about the 
device: 
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Figure 7.2. Device details 

 
 
Defining the device status 
 
To define the device status in the tracking list, click the list box in the Status column related to the 
device: 
 

 
Figure 7.3. Device status 

 
Select the option: 

• Off-line: the device is not communicating because it was removed from the plant. 
• Bad Communication: the device is connected to the plant but has communication 

problems. 
 
Click the button Submit to apply the alterations to the device. The tracking event will be 
automatically acknowledged. See the example below: 
 

 
Figure 7.4. Defining the Device status 
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Defining the device location 
 
To define the device's location in the tracking list, click the list box in the Location column related to 
the device: 
 

 
Figure 7.5. Device Location 

 
Select the option: 

• On Site: the device is operating in the plant. 

• Warehouse: the device is stored in the warehouse. 

• Maintenance Shop: the device was removed from the plant for maintenance. 

• Disposed: the device was removed from the plant and discarded. 
 
Click the button Submit to apply the alterations to the devices. 
 
 
Acknowledging the Tracking Event 
 
Click the link ACK in the Tracking View page to acknowledge the event. 
 

NOTE 

The tracking event is automatically acknowledged when the user defines the device status in the 
Tracking View page, clicking the list box in the Status column related to the device. 

 
The Acknowledge Tracking window will open: 
 

 
Figure 7.6. Acknowledge Window 

 
 



AssetView 4.2 - User’s Manual 
 

7.4 

• Select the cause of the tracking event: Off-line if the device was removed from the plant or 
Bad Communication if the device has communication problems. 

 
• Select the option Generate Maintenance to schedule maintenance for the device, 

corrective or proactive. See section Scheduling Maintenances for an Event for details. 
 

• Select the option E-mail Notification to send e-mails to the plant administrator and 
technicians. 

 
Click the button Submit to acknowledge the tracking event. 
 

NOTE 

When acknowledging a tracking event, you do not have to define maintenance for the device, or 
the e-mail address to be notified. 
To create a maintenance related to an acknowledged event, or define an e-mail address, click 
the link ACK in the Tracking View page and the Acknowledge window will open. 

 
The Tracking View page will be updated and a check mark will appear in the column ACK for the 
events that have been acknowledged. Observe the figure below: 
 

 
Figure 7.7. Event Acknowledged 

 
 

Diagnostic 
 
The Diagnostic View page shows the events caused by failure notifications or operational 
conditions programmed by the user to be monitored by the system. 
 

 Indicates normal condition, no communication problem occurred. 

 Indicates that a diagnostic event has occurred. 
 
When a diagnostic event occurs, it appears in the Diagnostic View. Click the link Status > 
Diagnostic in the topology tree to open the list of diagnostic events: 
 

 
Figure 7.8. Diagnostic View 

 
Click the device icon in the Device column to open the corresponding home page. 
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The Block column indicates the tag of the block where the diagnostic event occurred. The Bridge 
and Channel columns indicate, respectively, the tag of the controller and to which channel the 
instrument is connected. 
 
Click the magnifying glass icon to open a new window that shows detailed information about the 
diagnostic related to the block of the device: 
 

 
Figure 7.9. Device Details 

 
Acknowledging the Diagnostic Event 
 
Click the link ACK in the Diagnostic View page to acknowledge the event. 
 
The Acknowledge Diagnostic window will open: 
 

• Select the option Generate Maintenance to schedule maintenance for the device, 
corrective or proactive. See section Scheduling Maintenances for an Event for details. 

• Select the option E-mail Notification to send e-mails to the plant administrator and 
technicians. 

 

 
Figure 7.10. Acknowledging the Event 

 
Click the button Submit to acknowledge the diagnostic event. 
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NOTE 

When acknowledging a diagnostic event, you do not have to define maintenance for the device, 
or the e-mail address to be notified. 
To create maintenance for an acknowledged event, or define an e-mail address, click the link 
ACK in the Diagnostic View page and the Acknowledge window will open. 

 
The Diagnostic View will be updated and a check mark will appear in the column ACK for the 
events that have been acknowledged. Observe the figure below: 
 
 

 
Figure 7.11. Event Acknowledged 

 
 
Configuring Diagnostic Events 
 
Click the link Diagnostic > Configuration on the topology tree, as indicated in the figure below, to 
open the monitored instruments and instruments with diagnostic events. 
 

 
Figure 7.12. Configuring Diagnostic Events 

 
 
Click the instruments to view the events. 
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Figure 7.13. Selecting the instrument 

 
The list shows all diagnostic events of the instrument. 
 
To activate a diagnostic event, mark the option in the corresponding column: 
 

 Show: shows an event on the Diagnostic View page. 

 Show Report: the selected diagnostic will be listed on the report. 

 Send E-mail: sends an e-mail to the user, describing the diagnostic. Click the link 
Configure referring to a diagnostic to select the instruments from which the diagnostics will 
be send by email when the respective events occur. 

 

 
Figure 7.14. List of Diagnostic Events 

 
The example from the following figure shows the diagnostic DEVIATION LIMIT EXCEEDED for a 
FY302 device: 
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Figure 7.15. Configuring sending e-mail of Diagnostic Event 

 
Select the devices, through their tags, on which the user wants to receive notification e-mails.  
 
The figure below shows an example of a notification e-mail related to a diagnostic. 
 

 
Figure 7.16. Notification of a Diagnostic Event 

 
 
Through the Batch settings option the user can select some diagnostic events simultaneously. 
 

 
Figure 7.17. Batch Settings option 

 
 
Click Batch settings in the DEVIATION LIMIT EXCEEDED diagnostic window, shown above, and 
the following window will open. 
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Figure 7.18. Selecting some diagnostic events for the notification e-mail 

 
Select the necessary diagnostic events, and notification e-mails related to that list of selected 
devices will be sent. 
 
 
Filtering diagnostics 
 
Click the funnel icon to filter the diagnostic. 
 

 
Figure 7.19. Filtering a Diagnostic 

 
 

Scheduling Maintenances for an Event 
 
At the Acknowledge window, for tracking and diagnostic events, select the option Generate 
Maintenance to schedule maintenance for the device. Click Submit to open the window as shown 
in the example below: 
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Figure 7.20. Generating Maintenance 

 
Select the type for the maintenance: proactive or corrective. In the field Description, describe the 
procedure for executing the maintenance. Click the button Submit to conclude. The window below 
should appear confirming the maintenance was created: 
 

 
Figure 7.21. Confirming Maintenance 

 



Section 8 
 

8.1 

 

MANAGING DEVICE MAINTENANCES 
 
 
Procedures for managing maintenances are available from the Maintenances menu in the topology 
tree, as indicated in the figure below: 
 

 
Figure 8.1. Maintenances Menu 

 
Click the link Maintenances > List in the topology tree to open the list of scheduled maintenances: 
 

 
Figure 8.2. Maintenances List 

 

The Type column indicates the type of the maintenance. The icon  indicates that the maintenance 

is recurrent, while the icon  indicates the maintenance should be executed only once. 
 
Click the device icon in the Device Tag column to open the home page of the device. 
 
 

Editing Equipment Information 
 
Click the link Maintenances > Equipment in the topology tree to display the list of equipment 
registered in AssetView and other equipment registered to represent plant control assets. 
 
For example, add a motor as an equipment and generate maintenances for this equipment, as 
described in subsection Adding Preventive and Predictive Maintenances. 
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Figure 8.3. Equipment List 

 
Use the navigation buttons at the bottom of the page to browse the list of equipment, as indicated in 
the figure below: 
 

 
Figure 8.4. Navigation Bar 

 
Adding Equipment 
 
Fill the form typing the information related to the equipment and click the button Submit to add the 
equipment to the Equipment list. 
 

 
Figure 8.5. Adding Equipment 

 
A message box informs the equipment was created. Click Ok to conclude and the new equipment is 
register as a plant asset. 
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Editing the information 
 
To change the information related to the equipment, click the icon  in column Edit corresponding 
to the equipment and the form in the upper part of the page displays the data. See the example 
below: 
 

 
Figure 8.6. Editing Data 

 
Type the desired information and click Submit. A message box indicates the information was 
updated with success. Click Ok to conclude. 
 
 
Deleting Equipment 
 
To delete the equipment from the list of plant assets, click the icon  in column Delete 
corresponding to the equipment. 
 

 
Figure 8.7. Deleting Equipment 

 
The page loads the information related to the selected equipment. Click Delete to confirm the 
operation and remove the equipment from the list, or click Cancel to abort the operation. See the 
example: 
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Figure 8.8. Confirming the Operation 

 
 

Adding Preventive and Predictive Maintenances 
 
To schedule maintenance for a specific device, click the link Maintenances > New in the topology 
tree. The Maintenance Scheduling page will be loaded: 
 

 
Figure 8.9. Adding Device Maintenances 

 
1. In the field Occurs, select the maintenance occurrence: customized, daily, weekly, monthly 

or annual. 

2. Select the option Recurrent in case the maintenance should occurs repeatedly. 

3. In the field Starting at, select the date and the time that the maintenance should start. To 
customize the maintenance starting date, click the option Custom, select the maintenance 
date and the time. 

4. Configure the maintenance alert in the field Safety Period, selecting the number of days 
that the user should be notified in advance. 

5. In the field Notify user by e-mail, select Yes in the options list to send e-mails to the users, 
and add the e-mail address of the user that will be notified about the maintenance. 

6. Click the button Next to proceed describing the maintenance details: 
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Figure 8.10. Maintenance Details 

 
7. Type the title of the maintenance. 

8. Select the device. 

9. Select the type of the maintenance: preventive or predictive. 

10. Type the instructions to perform the maintenance. 

11. Click Next to conclude and update the Maintenances List. 
 
 

Editing the Maintenance 
 
In the topology tree, click the link Maintenances > List to open the list of scheduled maintenances. 
 

In the column Action, click the edit icon, , related to the device, to open the Maintenance Edit 
window. 
 

 
Figure 8.11. Editing the Maintenance 

 
Edit the necessary information and click the button Submit to apply the alterations. 
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Removing a Maintenance 
 
In the topology tree, click the link Maintenances > List to open the list of scheduled maintenances. 
 

In the column Action, click the delete icon, , related to the device. 
 

 
Figure 8.12. Removing a Maintenance 

 
Click Ok to confirm the operation and remove the selected maintenance. 
 

Sending Service Orders 
 
In the topology tree, click the link Maintenances > List to open the list of scheduled maintenances. 
 

In the column Action, click the send service order icon  related to the device. This icon will only 
be available if any e-mail address was assigned to the maintenance. The window to edit the service 
order opens: 
 

 
Figure 8.13. Sending a Service Order 

 
Type the instructions to be sent to the user and click the button Send to send the e-mail. The figure 
below should appear confirming that an e-mail has been sent: 
 

 
Figure 8.14. Confirming the Service Order 
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Searching for Maintenances 
 
To search for a specific maintenance, click the link Maintenances > Search in the topology tree. 
 
Searching a period 
 
The default Maintenance Search page is shown in the figure below: 
 

 
Figure 8.15. Searching for Maintenances 

 
1. Select the beginning of the search in the field Start Date and the end of the search in the 

field End Date, clicking the icon  to open the Calendar dialog box. 

 
Figure 8.16. Calendar 

2. In the field Device Tag, filter the tag of a specific device. 

3. In the field Maintenance, filter the name of the maintenance defined by the user. 

4. Click the button Search to view the results. 

 
The page with the search results will be loaded. Click the link of the device name to view the 
information about the maintenance. 
 

 
Figure 8.17. Search Results 
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Searching maintenance during the month 
 
Click the button Month to view the maintenances scheduled for the month: 
 

 
Figure 8.18. Month Calendar 

 
Click the link of the maintenance name to view the instructions related to the maintenance. 
 
 
Searching maintenance during the week 
 
Click the button Week to view the maintenances scheduled for a selected week: 
 

 
Figure 8.19. Week Calendar 

 
1. Select the beginning of the search in the field Start Date clicking the icon  to open the 

Calendar dialog box. 

2. Select the number of weeks from the Week menu. 

3. Select the time interval in the Scale area. 

4. Select the view mode for the week: horizontal or vertical. 

5. Click the link of the maintenance name to view the instructions related to the maintenance. 
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Opening the Maintenances History 

 
To list the maintenances that have been executed, click the link Maintenances > History in the 
topology tree. The History Search page will be loaded: 
 

 
Figure 8.20. Searching for the maintenances executed 

 
1. Select the starting date for the search in the field Start Date. 

2. Select the ending date for the search in the field End Date. 

3. In the field Device Tag, filter the tag of a specific device. 

4. In the field Maintenance, filter the name of the maintenance defined by the user. 

5. Click the button Search to view the results. 
 
The page with the results for the search will be loaded: 
 

 
Figure 8.21. Maintenances History 

 

The icon  in the first column indicates that the maintenance has been executed. 
 

The icon  indicates that the maintenance has been removed. 
 
 

Opening the Alarms List 
 
To list the alarms that indicate the status of the scheduled maintenances, click the link 
Maintenances > Alarms in the topology tree. The page with the alarms list will be loaded: 
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Figure 8.22. Maintenance Alarms 

 
The color indicates the severity of the alarm: 
 

 Indicates the maintenance should be executed in the near future. 

 Indicates the deadline for the maintenance to be executed. 

 Indicates the date of the maintenance has expired. 

 

To register the maintenance, click the icon  to open the Maintenance Registration window. 
Type the description of the executed maintenance procedure and click the button Register to 
confirm that the maintenance has been executed. 
 

 
Figure 8.23. Registering the Maintenance 

 
A message box will open confirming the procedure. Click Ok to conclude. 
 

To remove the scheduled maintenance, click the icon  related to the maintenance and, in the 
Maintenance Registration window, type a brief explanation about canceling the maintenance and 
click the button Remove. A message box will open confirming the procedure. Click Ok to conclude. 
 
 

Maintenance Templates: Using the AssetView Maintenance Wizard 
 
The user can create templates for the preventive maintenance of a device, and register these 
maintenances in the AssetView database. When the device is registered by the AssetView Server, 
the maintenances are automatically added to the List of Programmed Maintenances. 
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Maintenances templates are created using the AssetView Maintenance Wizard. To run this 
application, double-click the file AVMaintenanceWizard.exe located in the AssetView installation 
directory, inside the bin folder. The default installation path is “C:\Program 
Files\Smar\AssetView\bin\”. 
 

 
Figure 8.24. AssetView Maintenance Wizard 

 
 
Creating Maintenance Templates 
 
Go to the File menu and click New Template. Then, on the Maintenances menu, select the option 
New Maintenance Wizard to open the Maintenance Template Wizard dialog box: 
 

 
Figure 8.25. Creating Maintenance Templates 

 
Type the name for the maintenance template and describe the maintenance procedure that should 
be executed. Click Next to continue. 
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Figure 8.26. Defining the Schedule 

 
In the field Occurs, select the maintenance occurrence: customized, daily, weekly, monthly or 
annual. According to this selection, define the hour, the day of the week, the day of the month or the 
day of the year that the maintenance should be executed or repeated. 
 
Configure the maintenance alert in the field Safety Period, selecting the number of days that the 
user should be notified in advance about the maintenance. Click Finish to conclude. 
 
 
Saving Maintenance Templates 
 
On the File menu, click Save to open the Save Maintenance Template dialog box. The 
maintenance templates are saved in XML file format. 
 

 
Figure 8.27. Saving the Maintenance Template 

 
Type the name for the file and click Save to conclude. 
 
 

IMPORTANT 

The maintenance template file must be saved on the AssetView folder, following the default Web 
pages structure on the Device Support folder. The default path is:  
C:\Program Files\Smar\Assetview\Web Pages\Device Support\<manufacturer 
code>\<device type code> 

For example, if you create a maintenance template for Smar’s FY302, the file must be saved in 
C:\Program Files\Smar\Assetview\Web Pages\Device Support\000302\0006. 
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Opening Maintenance Templates 
 
On the File menu, click Open Template to open the Open Maintenance Template dialog box. 
Select the icon of the maintenance file and click Open. 
 

 
Figure 8.28. Opening the Maintenance Template 

 
 
Editing Maintenance Templates 
 
In the field Maintenances Group, select the icon of the maintenance to be edited and click Edit, at 
the bottom of the AssetView Maintenance Wizard window. Or go to the Maintenances menu and 
click New Maintenance Wizard. The fields will be available for edition: 
 

 
Figure 8.29. Editing a Maintenance 

 
You can change the title of the maintenance and the description. 
 
To edit the scheduling, click the button at the Recurrence Type field to open the Recurrence Type 
dialog box: 
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Figure 8.30. Editing the Scheduling 

 
Select the recurrence type for the maintenance, define the recurrence period and click Ok to return 
to the AssetView Maintenance Wizard window. 
 
It is also possible to edit the period that the user should be notified in advance about the 
maintenance. Select the number of days in the Safety Period box. 
 
To conclude the edition, click End Edit, at the bottom of the AssetView Maintenance Wizard 
window. 
 
 
Removing Maintenance Templates 
 
To remove a maintenance template, select its icon on the Maintenances Group box. On the 
Maintenances menu, select the option Remove Maintenance. 
 
The message box below will open to confirm the operation. Click Yes to remove the maintenance or 
click No to cancel the operation. 
 
 
 



Section 9 
 

9.1 

DEVICE LIBRARY 
 
The Device Library is a set of information provided by manufacturers related to the devices, such 
as user’s manuals, calibration procedures, preventive maintenance items, device-related diagrams 
and images, and notes. Observe the example below: 
 

 
Figure 9.1. Device Library Page 

 
Select the device on left panel to open the Device Library Explorer tabs on the right panel. 
 
 

Device Images 
 
Once a device is selected, the list of related images is shown at the Explorer tab. The example of 
the following figure shows a list of image files referring to the device LD302 from Smar: 
 

 
Figure 9.2. Example of Device Images 

 
Click the image file name to view the image. 
 
 



AssetView 4.2 - User’s Manual 
 

9.2 

Adding Images 
 
To include an image related to the device, at the bottom of the Explorer tab, type the name of the 
file or click Browse to locate the file, at the Upload local file to library area: 
 

 
Figure 9.3. Adding Images 

 
The dialog box to locate the file will open. Select the file of the image and click Open. At the 
Explorer tab, select the folder Images and click Upload. 
 
The link to the new image will be created in the list of images and a copy of the original file will be 
created in the device’s folder, in the device’s manufacturer directory located at “AssetView\Web 
Pages\ DeviceLibrary\MANUFACTURERS\”, at the default System302 installation directory. 
 
 
Removing Images 
 
At the Explorer tab, expand the device’s tree, mark the image(s) that will be deleted and click 
Delete. 
 

 
Figure 9.4. Removing Images 

 
The link to the image will be deleted and the file will be removed from the related device’s folder, in 
the manufacturer directory at the default installation path ”\AssetView\Web 
Pages\DeviceLibrary\ MANUFACTURERS\”, at the default System302 installation directory. 
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Device Manuals 
 
Click the Manual icon to open the documentation file from the device: 
 
 
Adding Manuals 
 
At the bottom of the Explorer tab, type the name of the file or click Browse to locate the file, at the 
Upload local file to library area: 
 

 
Figure 9.5. Adding a Manual 

 
After selecting the manual file, select the folder Manuals and click Upload. 
 
The link to the new manual will be created in the list of manuals and a copy of the original file will be 
created in the device’s folder, in the device’s manufacturer directory located at “AssetView\Web 
Pages\ DeviceLibrary\MANUFACTURERS\”. 
 
For example, if a manual was added to Smar FY302, the copy of the file will be created in the 
default installation directory: “C:\Program Files\Smar\AssetView\Web 
Pages\DeviceLibrary\MANUFACTURERS\SMAR\FY302\manual”. 
 
 
Removing Manuals 
 
At the Explorer tab, expand the device’s tree, mark the manual file(s) that will be deleted and click 
Delete. 
 
The link to the manual will be deleted and the file will be removed from the related device’s folder, in 
the manufacturer directory at the default installation path “\AssetView\Web 
Pages\DeviceLibrary\ MANUFACTURERS\“. 
 
 

Managing Other Files 
 
Files related to descriptions or references for a device, or worksheets for example, are managed 
similarly to image and manual files. 
 
To add a new file, type the name of the file or click Browse to locate the file, at the Upload local 
file to library area. After selecting the file, select the folder Others and click Upload. The link to the 
new file will be created in the list of files. 
 
To remove a file, mark the name of the file that will be deleted and click Delete. 
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Managing Device Notes 
 
Click a device icon to display the Notes tab which list of notes related to the device. See the 
example below: 
 

 
Figure 9.6. Example of Notes for the LD302 

 
 
Adding Notes 
 
To add a note to a device, type the text and click the button Insert. See the example below: 
 

 
Figure 9.7. Adding a Note 

 
The text will be displayed on the list of notes for the device. 
 

 
Figure 9.8. Device Note 

 
 
Updating a Note 
 
To update a note, click the button Edit corresponding to the note. 
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Figure 9.9. Editing a Note 

 
The text box to edit the note will open. Edit the text and click Update to confirm the alterations: 
 

 
Figure 9.10. Updating a Note 

 
To cancel the alterations, click Cancel and the text will not be altered. 
 
 
Removing Notes 
 
To remove a note, click the button Delete corresponding to the note. See the example below: 
 

 
Figure 9.11. Deleting Notes 

 
The note will be removed from the list of notes for the device. 
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Section 10 
 

10.1 

 

KNOWN PROBLEMS AND LIMITATIONS 
 
 
1. AssetView Server is monitoring the changes of the parameters (Tracking Activated). An 

online Web page from AssetView is requested and all fields in the page are blank, 
instead of showing the values. At the same time, the monitoring procedure (Tracking) 
stops. 

 
Run the dcomcnfg application, select the application Smar OPC & Conf Server for DFI302 and 
click Properties. At the Identity tab, select the option The Interactive User. Click Ok to conclude. 
 

 
Figure 10.1. Configuring the DCOM Properties 

 
 
2. When trying to execute an operation in the page, the following error message appears: 
 

 
Figure 10.2. Error Message 

 
The user logged probably doesn’t belong to the Engineers group. Refer to the section User 
Permission on Section 1, in this manual. 
 
IMPORTANT! If the user belongs to a domain, the group Engineers must exist in the domain 
server and the user must be added to this group to perform specific operations. 
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3. When trying to start the AssetView Server after the installation, the following error 
message appears: 

 

 
Figure 10.3. Database Installation Error 

 
This message occurs if Windows is not installed in drive C and the System302 version is prior to 
version 6.1.3.3. 
 

• If the user is running the AssetView Server with Windows 2000, click Start > Settings > 
Control Panel > Administrative Tools > Data Sources (ODBC). 

• If the user is running the AssetView Server with Windows NT, click Start > Settings > 
Control Panel > ODBC. 

 
The ODBC Data Source Administrator dialog box will open. Click the System DSN tab and 
double-click the AssetView data source name to open the dialog box. Click Select and locate the 
file AssetView.mdb in the folder “<System302 Installation Path>\AssetView\ 
Database\”. 
 
Click Ok and close the ODBC Data Source Administrator dialog box. 
 
 
4. When trying to open the AssetView main page, the following error message appears: 

"The page cannot be found". 
 
The Virtual Directories of AssetView might not have been created correctly during the installation. 
 
Refer to the Appendix A for specific information about the Virtual Directories. 
 
 
5. The Device icon in the Tracking window doesn’t have its normal state recovered after the 

communication is restored. 
 
Close the Tracking window and open it again by clicking View > Tracking View. 
 
 
6. IIS and .NET Framework installation: AssetView pages are not shown in the browser. 
 

 
Figure 10.4. AssetView Pages Blank 
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The Internet Information Services must always be installed before the .NET Framework. 
 
In case the installation order is inverted, follow the procedure below: 
 

a. On the Start menu, select Run and type cmd. The command interpreter window will open. 

b. Execute the file aspnet_regiis.exe located on the default directory 
“C:\WINDOWS\Microsoft.NET\Framework\v1.1.4322\”. On the command line, type: 

C:\WINDOWS\Microsoft.NET\Framework\v1.1.4322\aspnet_regiis.exe -i 

c. The Internet Information Services will be configured. Wait a few seconds until the 
procedure is concluded and close the command interpreter window. See the example 
below: 

 
Figure 10.5. Command Window 

 
d. Open the Control Panel, double-click the icon Administrative Tools and open the IIS 

window. 

e. Right-click the icon of the AssetView folder and select the option Properties. 

 
Figure 10.6. AssetView Folder Properties 

 

f. On the Properties dialog box, select the ASP.NET tab and select version 1.1.* of 
ASP.NET, as indicated in the figure below: 
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Figure 10.7. AssetView Folder Properties 

 

g. Click Ok to conclude and close the IIS window. 

 
 
 
 



Appendix A 
 

A.1 

ASSETVIEW VIRTUAL DIRECTORIES 
 
 

Configuring IIS 5.0 on Windows XP 
 
Creating the Virtual Directories 
 
If the virtual directories were not created during the System302 installation, it will be necessary to 
create them according to the procedure described below. 
 
Click Start > Settings > Control Panel and double-click Administrative Tools. Start the Internet 
Services Manager. The Internet Information Services Manager window will open. 
 
Expand the directory tree of the server machine and right-click the Default Web Site directory. 
Select New > Virtual Directory. 
 

 
Figure A.1. IIS Manager 

 
The Virtual Directory Creation Wizard dialog box will open. Click Next and type the name 
AssetView to create the virtual directory. Click Next. 
 

 
Figure A.2. Creating the Virtual Directory 
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Select the path of the new virtual directory. The default installation path is “C:\Program 
Files\Smar\AssetView\Web Pages“. Or click Browse and select the AssetView Web Pages 
directory. 
 

 
Figure A.3. Locating the AssetView Directory 

 
Click Next. On the following dialog box, select the options Read and Run scripts (such as ASP). 
 

 
Figure A.4. Configuring the permissions for the Virtual Directory 

 
Click Next to complete the wizard and click Finish to conclude. 
 
Check if the virtual directory was created at the Internet Information Services window. 
 
Once the virtual directory is created correctly, it will be necessary to configure the properties of the 
virtual directory according to the section below. 
 
 
Configuring the Properties of the Virtual Directories 
 
At the Internet Information Services window, expand the directory tree of the Default Web Site 
directory, right-click the AssetView virtual directory and select Properties from the menu. 
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Figure A.5. AssetView Virtual Directory 

 
The AssetView Properties dialog box will open. 
 
At the Virtual Directory tab, select the options Read and Index this resource in the Local Path 
rectangle. In the Application Settings area, select Low (IIS Process) in the Application 
Protection box. 
 

 
Figure A.6. Properties of the Virtual Directory 

 
Select the HTTP Headers tab and mark the option Enable Content Expiration and Expire 
Immediately, as indicated below: 
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Figure A.7. Properties of the Virtual Directory 

 
Select the ASP.NET tab and select version 1.1.* for ASP.NET, as the example in the figure below: 
 

 
Figure A.8. Selecting the ASP.NET version 

 
Click OK to close the dialog box and close the AssetView Properties dialog box. 
 
 

Configuring IIS 6.0 on Windows Server 2003 
 
Configuring the Application Pool 
 
It is necessary to create the Application Pool in IIS 6.0 for AssetView: 
 

i. Open the Internet Information Services window. Click Start > Settings > Control Panel 
and double-click Administrative Tools. Then double-click Internet Information Services 
Manager. 

ii. Right-click the Application Pool icon and select New > Application Pool. 

 
Figure A.9. Creating the Application Pool 
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iii. The Add New Application Pool dialog box will open. 

 
Figure A.10. Application Pool Identification 

 
iv. Type SmarAssetViewPool as the Application Pool ID and click Ok. 

v. Right-click the SmarAssetViewPool icon and select Properties. 

 
Figure A.11. Application Pool Properties 

 
vi. The SmarAssetViewPool Properties dialog box will open. 

 
Figure A.12. AssetView Application Pool Properties 
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vii. Select the Identity tab, check the option Predefined and select Local System as the user 
account. 

viii. Click Ok to conclude. 

 
 
Creating the Virtual Directories 
 
Now, it will be necessary to create the Virtual Directories. 
 
On the Internet Information Services Manager window, expand the directory tree of the server 
machine and right-click the Default Web Site icon. Select New > Virtual Directory. 
 

 
Figure A.13. Creating the Virtual Directory for the AssetView Application Pool 

 
The Virtual Directory Creation Wizard will open. Click Next and type AssetView as the alias of 
the virtual directory. Click Next. 
 

 
Figure A.14. Configuring the Virtual Directory 

 
Then select the path of the new virtual directory. The default installation path is C:\Program 
Files\Smar\AssetView\Web Pages. Or click Browse to locate the AssetView Web Pages 
directory. 
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Figure A.15. Locating the AssetView Directory 

 
Click Next to continue. On the following dialog box, select the options Read and Run scripts (such 
as ASP). 
 

 
Figure A.16. Configuring the Permissions for the Virtual Directory 

 
Click Next to complete the wizard then click Finish to conclude. 
 
Once the virtual directory is created correctly, it will be necessary to configure the properties of the 
virtual directory according to the Application Pool created previously. 
 
 
Configuring the Properties of the Virtual Directories 
 
On the Internet Information Services Manager window, right-click the AssetView virtual directory 
and click Properties. 
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Figure A.17. AssetView Virtual Directory 

 
The AssetView Properties dialog box will open. At the Virtual Directory tab, select the options 
Read and Index this resource in the Local Path rectangle. In the Application Settings area, 
select SmarAssetViewPool created previously as the Application pool for the virtual directory. 
 

 
Figure A.18. Properties of the Virtual Directory 

 
At the Directory Security tab, click Edit in the Anonymous Access and Authentication Control 
area. Verify that the Anonymous access option is selected. 
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Figure A.19. Configuring the Authentication Method 

 
Click OK to close the dialog box and close the AssetView Properties dialog box. 
 
Select the HTTP Headers tab and mark the option Enable Content Expiration and Expire 
Immediately. Then, select the ASP.NET tab and select version 1.1.* for ASP.NET. 
 
The IIS configuration for AssetView is complete. 
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ASSETVIEW DATABASE BACKUP 
PROCEDURES 
 
 
Use the AssetView Backup application to backup the AssetView database. The AssetView 
Backup is easy to execute, and it can be used with the SQL Server or the MSDE database. 
 
The AssetView Backup must be located in the same directory of the file SmarAssetServer.exe, 
because these applications use the same connection (Assetview.udl). 
 
It is recommended to run the AssetView Backup application in the machine where the database 
server is installed. Even if the AssetView Backup is executed in a remote machine, the backup will 
be saved in the machine where the database server is installed. 
 
 
Attention: 
 

• Store the backup files in a secure place. It is recommended to save three copies of each 
backup file and store them in different locations. 

• Execute the backup procedure on regular intervals. 

• Define a reasonable period of time to store old backup versions. 

 
IMPORTANT 

Before executing the AssetView Backup, make sure that the AssetServer is not being executed 
and the AssetView pages are not open. 

 

 

Creating the Backup File 
 

1. On the Start menu, select Programs > System302 > AssetView > Backup AssetView 
Database, as indicated below: 

 
Figure B.1. Starting the AssetView Backup 

2. The AssetView Backup window will open: 

 
Figure B.2. AssetView Backup Window 
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3. Select the option Backup AssetView Database to open the Backup AssetView dialog 
box. 

4. Select the folder where the backup file will be saved and type the name for the file. 

5. Click Save to conclude. 
 
 

Restoring the Database 
 
Before restoring the database, make sure the AssetServer is not being executed and the 
AssetView pages are not open. 
 
It will be necessary to create a new AssetView database before restoring an old database. Follow 
the steps described below: 
 

1. To create a new AssetView database, go to the Start menu and select Programs > 
System302 > AssetView > SqlServer Create Database. 

2. The Configure SQL Server Database window will open: 

 
Figure B.3. Configure SQL Server Database Window 

3. Select the name of the database server and click Create. 

4. A message box will open to confirm the operation. Click Yes to proceed and wait a few 
seconds until a message box confirms that the operation was successful. 

5. Click Ok and then click Close on the Configure SQL Server Database to conclude. 

6. On the AssetView Backup window, select the option Restore AssetView Database. The 
Backup AssetView dialog box will open. 

7. Select the icon of the backup file that will be restored and click Open. 

8. A message box will open to confirm the operation. Click Yes to proceed. 

9. Wait a few seconds until a message box confirms that the operation was successful. Click 
Ok to conclude. 

 
Figure B.4. AssetView Backup Database Restored 
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TUTORIAL: ASSETVIEW DEVICE WIZARD 
 
 
AssetView Device Wizard Foundation Fieldbus has a DD library for Foundation Fieldbus devices 
that contain information provided by the devices manufacturers, such as parameters and the 
corresponding enumerations. 
 
The execution file for AssetView Device Wizard Foundation Fieldbus is located on the 
System302 default installation path: C:\Arquivos de Programas\Smar\AssetView\bin. 
 
To run the Device Wizard, double-click the icon of the DeviceWizard.exe file. See the figure below: 
 

 
Figure C.1. Running AssetView Device Wizard 

 
The AssetView Device Wizard window will open: 
 

 
Figure C.2. AssetView Device Wizard window 
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Creating XML Templates for Devices 
 
AssetView Device Wizard creates XML templates for SMAR and third-parties devices from DD 
files. 
 
To create a XML template, click New on the main toolbar. The Device Support Explorer dialog box 
will open: 
 

 
Figure C.3. Creating templates 

 
Expand the manufacturer tree to list the types of devices available and their corresponding DD 
versions: 
 

 
Figure C.4. Selecting the DD version 

 
Select the DD revision and click Select to return to the AssetView Device Wizard window. 
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Figure C.5. Configuring a template 

 
The panel Select parameters from DD on the left side of the AssetView Device Wizard window 
shows the blocks supported by the selected device and the parameters available. 
 
At the Page combo box on the main toolbar, select the AssetView web page of the device where 
the configured parameters will be displayed. 
 
Then, expand the block icon to list the parameters supported by the block that will be configured. 
 

 
Figure C.6. Selecting parameters 

 
Mark the desired parameters and the panel Selected parameters on the right side of the 
AssetView Device Wizard window will show the selected parameters and related information. See 
the example below: 
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Figure C.7. Selected parameters 

 
The following Information are displayed for the parameters: 
 

 BitOtherBased: Only for diagnostic parameters. It indicates that when the parameter has 
an alarm status, the diagnostic Other from the parameter BLOCK_ERR is activated. 

 Byte: When the diagnostic parameter is an array, this attribute indicates which element is 
being considered. 

 Display Name: This attribute indicates the name of the parameter displayed on the 
AssetView web page. 

 Dynamic: When this attribute is True, the parameter is read online. If False, the parameter 
is read from the AssetView database. 

 Help: This attribute adds the description to the parameter. 

 MethodTrigger: It indicates that the value of the parameter is not altered when writing to 
the device. Writing acts only as a trigger. 

 Read Only: When True, the parameter is Read Only. If False, writing is enabled for the 
parameter. 

 
For Read Only parameters, it is only possible to read values from the parameters, that is, the user 
can not actuate on the device. 
 
For Read/Write parameters, it is possible to read values from the parameters and edit values 
according to the device operation, submitting new values to the device. 
 
If the selected parameter is an enumerador, check the enumerations on the bottom of the left panel. 
See the example below: 
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Figure C.8. Enumerations 

 
Click Save on the main toolbar to save the XML template. A dialog box indicates the progress. 
 

 
Figure C.9. Saving the XML template 

 
 

Opening a Template 
 
On the main toolbar, click Open to open an existent device template. On the dialog box, double-click 
the icon of the device template: 
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Figure C.10. Opening a device template 

 
To locate a template for a device, type the name of the device on the Filter area. 
 
 

Configuring Blocks 
 
On the AssetView Device Wizard window, select a block and click Block Settings on the main 
toolbar to open the dialog box that lists the blocks being used in the template. 
 
On the Block Settings dialog box, mark the column Supports AE corresponding to the block to 
enable alarm and events functionalities. Mark the column Tracking corresponding to the block to 
enable tracking. At the column Mnemonic corresponding to the block, define the block mnemonic 
used by AssetView. See the example below: 
 

 
Figure C.11. Configuring blocks 

 
 

Updating Enumerations 
 
On the AssetView Device Wizard window, select a parameter and click Update Enumerators on 
the main toolbar to customize enumerations for the parameter. On the Enumerators dialog box, 
type the value and the description for the selected parameter and click Add. See the example 
below: 
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Figure C.12. Enumerations 

 
To remove enumerations from the selected parameter, mark the items on the Enumerators dialog 
box and click Delete selected items. 
 
Click Close to return to the AssetView Device Wizard window. 
 
 

Configuring Pages 
 
On the main toolbar, click Page Settings to open the Page Settings dialog box and list the pages 
for the template. 
 
Mark the column Supports Recon corresponding to the desired page to enable the Calibration and 
Configuration pages to support Reconciliation pages: 
 

 
Figure C.13. Configuring Pages 
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Creating XML DD 
 
On the main toolbar, click the button Create XML DD to generate XML versions. For example, 
consider DD revision 0101 for a specific device and a new DD revision 0102 is available. When 
clicking Create XML DD, the XML file 0102_0101.xml is created to store both DD version. 
 

 
Figure C.14. Creating XML DD 

 
 

Configuring Images 
 
On the main toolbar, click the button Images Settings to select the image that will be displayed on 
the device’s main page and on the AssetView toolbar. See the example below. 
 

 
Figure C.15. Configuring images 
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TYPICAL SETTINGS  AND HOW TO 
INCLUDE MULTIPLE AREAS 
 
 
Typical settings to run AssetView  

 
1. After opening System302 Studio, make sure that the Areas are updated in the Maintenance 

Station and Syscon has already exported tags for each area. 

2. Make sure a valid License for AssetView is installed, so open AssetView Server. 

3. Inside the System302 Studio, open AssetView toolbox.  

4. Create a Database ( “machine name”\smar2005 ). 

5. Under [User Permission] > [Groups] > [Engineer] add “machine user”. 

6. Choose “HSE Ole Server” under OPC Server setting. 

7. Under [Configure Area] add a consolidated XML file. (see “ How to consolidate different 
areas in one XML file”). 

8. Launch Smar AssetView Server. 

9. Open Topology. 

10. Register Devices. Start tracking. 

11. If necessary to redo any setting, open [System302] > [AssetView] > InstallationGuide. 

12. To run AssetView Web browser use the Internet Explorer 6 (IE6), (IE7) or (IE8). The link is 
http://”MachineNameOrIP”//AssetView . 

13. ServerManager settings for AssetServer station  

 Supervision only 
 MVC disable 
 Update time = 20000 
 NoDataChange Timeout = 40000 
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How to consolidate different areas in one XML file 
 

 Go to folder [Smar\AssetView\Bin] . 

 Open AV_Topology.exe and open first Area file.  

 Save as a first XML file. 

 Repeat these steps to second Area file. 

 Using a XML editor (e.g Notepad++), open the second XML file and copy the Bridges 
section. Insert these Bridges from second XML file to first XML file, generating a third XML 
file including all the Bridges inside Topology structure. The merge procedure need to be 
done carefully. The following example show the Tags structure and where is the position (*) 
to merge Bridges: 

 
 <Project><Topology><Bridge “HSE HOST”><Channel> 
  <Bridge> 
   <Block> 
   … 
   <Channel> 
    <FF Device> 
     <Block> 
     … 
    </FF Device> 
   </Channel> 
  </Bridge> 
  … 
 
  (* insert here new Bridges) 
 
 </Channel></Bridge></Topology></Project> 
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